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UKRATKO O JEDINSTVENOM PORTALU POREZNE UPRAVE 

ŠTO OMOGUĆUJE 

Porezna uprava je i do sada nudila mnoge e-usluge preko sustava elektroničkih usluga ePorezna, 

no prvenstveno poduzetnicima. Uspostavom Jedinstvenog portala Porezne uprave (dalje u tekstu 

JPPU) proširuju se e-usluge dostupne poduzetnicima, ali se omogućuje korištenje velikog broja e-

usluga Porezne uprave i građanima povezivanjem sa sustavom e-Građani.  

Portal JPPU omogućuje poreznim obveznicima interakciju s elektroničkim uslugama Porezne 

uprave u smislu dvostrane komunikacije i ispunjavanja poreznih obveza. Kroz JPPU porezni 

obveznici i ovlaštenici poreznog obveznika mogu na efikasan način: 

✓ upravljati podacima poreznog obveznika 

✓ pregledavati porezne i druge podatke u evidenciji Porezne uprave 

✓ podnositi elektroničke obrasce 

✓ podnositi elektroničke zahtjeve 

✓ tražiti povrat poreza  

✓ ostvarivati elektroničku komunikaciju s Poreznom upravom s ciljem ispunjenja poreznih 

obveza.  

 

JPPU aplikacija središnje je mjesto na kojem porezni obveznici mogu pristupiti svim elektroničkim 

uslugama koje nudi Porezna uprava prema načelu One-Stop-Shop1, i to u bilo kojem trenutku 

otvaranjem internet adrese aplikacije u jednom od preglednika: Internet Explorer, Mozilla Firefox, 

Google Chrome, Microsoft Edge i Opera. Aplikacija je dostupna poreznim obveznicima putem 

postojeće adrese elektroničkih usluga Porezne uprave:   

https://e-porezna.porezna-uprava.hr 

 

Korištenjem portala JPPU možete na brz i jednostavan način koristiti elektroničke usluge Porezne 

uprave. Portal osigurava pristup uslugama na praktičan i lagan način za sve kategorije poreznih 

obveznika uz mogućnost korištenja usluga u bilo koje vrijeme i s bilo kojeg mjesta. Korištenje 

aplikacije je sigurno, a tajnost i nepovredivost podataka zajamčena.  

U sklopu aplikacije JPPU dostupne su sljedeće usluge:  

1. Upravljanje podacima poreznog obveznika 

1.1. Profil poreznog obveznika 

1.1.1. Informacije o poreznom obvezniku 

1.1.2. Obveze 

1.1.3. Ovlaštenici 

 

1 Načelo pružanja potpune usluge na jednom mjestu. 

https://e-porezna.porezna-uprava.hr/
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1.1.4. Porezno knjigovodstvena kartica (PKK) 

1.1.5. Porezna kartica (PK) 

1.1.6. Moj JOPPD 

1.1.7. Provjeri šifru općine 

1.1.8. Uvid u neoporezive primitke JOPPD 

1.1.9. Uvid u umanjenje mjesečne osnovice doprinosa MO I stup 

1.1.10. Uvid u iskorištene osobne odbitke 

1.1.11. Uvid u uplaćene predujmove 

1.1.12. Korisnički pretinac 

1.2. Administracija 

1.3. Informacije o korisniku 

2. Podnošenje obrazaca i zahtjeva elektroničkim putem 

2.1. Porez na dodanu vrijednost 

2.2. Igre na sreću i nagradne igre 

2.3. Porez na dohodak i doprinosi 

2.4. Porez na dobit  

2.5. Porez na potrošnju 

2.6. Obrazac preknjiženja 

2.7. Porez na premije osiguranja od auto. odgovornosti 

2.8. Zahtjev za registriranje za potrebe poreza na dodanu vrijednost  (Obrazac P-PDV) 

2.9. Prijava u registar poreznih obveznika - RPO 

2.10. Zahtjev za izdavanje porezne potvrde 

2.11. Zahtjev za izmjenom podataka u registru poreznih obveznika 

2.12. Zahtjev za povrat doprinosa iznad najviše osnovice 

2.13. Zahtjev za ovjeru PKK 

2.14. Zahtjev za promjenu načina oporezivanja 

2.15. Zahtjev za zastaru 

2.16. Zahtjev za prigovor/žalbu 

2.17. Zahtjev za upravni ugovor 

2.18. Prijedlog za sklapanje porezne nagodbe 

2.19. Izdavanje/izmjena PK (Porezne kartice) 

2.20. Zahtjev za registraciju izvjestitelja AEOI CRS/DAC2 

2.21. Zahtjev za registraciju izvjestitelja AEOI CbCr/DAC4 

2.22. Zahtjev za prijavu podataka bitnih za oporezivanje porezom na nekretnine 

2.23. Zahtjev / Izjava o promjeni načina oporezivanja 

2.24. Zahtjev za promjenu poreznog razdoblja 

3. Pregled i dostava poreznih obrazaca i zahtjeva 

3.1. Dostava obrazaca 

3.2. Pregled dostavljenih obrazaca 

3.3. Pregled pohranjenih obrazaca 

3.4. Dostava zahtjeva 
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3.5. Pregled dostavljenih zahtjeva 

4. Elektroničko potpisivanje obrazaca i zahtjeva (PKI) 

5. Elektronički obrazac punomoći 

6. Web servisi (G2B e-usluga) 

7. Usluge iz drugih sustava 

 

 

ZAKONSKA OBVEZA KORIŠTENJA ELEKTRONIČKIH USLUGA  

Članak 77. stavak 5.  Pravilnika o porezu na dohodak (NN 10/17, 128/17, 106/18, 1/19, 80/19, 1/20, 

74/20, 1/21, 102/22, 112/22, 156/22, 1/23, 56/23, 143/23, 16/25) propisuje da se  izvješće na 

Obrascu JOPPD za više od 3 porezna obveznika odnosno fizičke osobe i/ili kada je podnositelj 

izvješća korisnik sustava elektroničkog servisa Porezne uprave JPPU, obvezno podnosi 

elektroničkim putem u okviru sustava JPPU na način propisan posebnim propisima te tehničkim i 

ostalim uputama.  U članku 74. stavak 6, Općeg poreznog zakona (NN 115/16, 106/18, 121/19, 

32/20, 42/20, 114/22, 152/24) propisana je odredba o obveznom podnošenju elektroničkih 

obrazaca za porezne obveznike koji su razvrstani u srednje ili velike poduzetnike u smislu odredbe 

Zakona o računovodstvu i sve obveznike poreza na dodanu vrijednost. Sve te odredbe uokvirene 

su u Pravilniku o provedbi OPZ-a (NN 45/19, 35/20, 43/20, 50/20, 70/20, 74/20, 103/20, 114/20, 

144/20, 2/21, 26/21, 43/21, 106/21, 144/21, 156/22, 16/25 čl.62, st.1.) koji govori da su porezni 

obveznici iz članka 74. stavka 6.  OPZ-a obvezni  podnositi sve porezne prijave i druge podatke 

bitne za oporezivanje elektroničkim putem i to čine korištenjem sustava ePorezna za sve prijave i 

izvješća za koje postoji mogućnost njihovog podnošenja korištenjem sustava ePorezna-JPPU.  

 

 

PRISTUP JEDINSTVENOM PORTALU POREZNE UPRAVE 

Jedinstveni portal porezne uprave dostupan je putem web adrese: 

https://e-porezna.porezna-uprava.hr 

Aplikacija JPPU se koristi na način da porezni obveznik popuni elektronički dokument (npr. PDV 

obrazac), potpiše ga elektronički korištenjem digitalnog certifikata (Zakon o provedbi Uredbe (EU) 

br. 910/2014 Europskog parlamenta i Vijeća od 23. srpnja 2014. o elektroničkoj identifikaciji i 

uslugama povjerenja za elektroničke transakcije na unutarnjem tržištu i stavljanju izvan snage 

Direktive 1999/93/EZ), provjeri njegovu matematičko logičnu ispravnost te pošalje, a sustav 

Porezne uprave preuzima obrazac, provjerava i šalje na daljnju obradu. Za vrijeme obrade 

podataka korisnik je obvezan redovito provjeravati status poslanog obrasca. Svu programsku 

podršku (aplikativni softver) potrebnu za ispunjavanje obrasca, njegovo digitalno potpisivanje, 

enkripciju, slanje u Poreznu upravu, primitak odgovora itd. osigurava Porezna uprava. 

 

https://e-porezna.porezna-uprava.hr/
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KAKO POSTATI KORISNIKOM  

Kako bi ostvario pristup JPPU i mogao se koristiti e-uslugama, porezni obveznik mora posjedovati 

elektroničku vjerodajnicu. Građanima i poduzetnicima dostupne su različite e-usluge i različiti 

zahtjevi za elektroničke vjerodajnice koje mogu iskoristiti da bi ostvarili pristup.  

Korisnikom se smatra bilo koja osoba koja se može prijaviti u sustav JPPU, a to može biti porezni 

obveznik ili opunomoćenik. Porezni obveznik može biti : građanin ili poslovni (fizička ili pravna 

osoba) korisnik. 

Porezni obveznik je osoba koja koristi sustav, a zastupa sebe kao građanina, obrt, slobodnu 

djelatnost ili tvrtku kao pravnu osobu. 

Opunomoćenik predstavlja korisnika koji posreduje u korištenju elektroničkih usluga u ime i za 

nekog drugog poreznog obveznika. Porezni obveznik (ili njegov zastupnik/zastupnici) odlučuje i 

formalno prenosi potrebna ovlaštenja (prava korištenja) na opunomoćenika. 

 

 

GRAĐANI 

Građani mogu koristiti elektroničke usluge Porezne uprave prijavom putem sustava NIAS 

(Nacionalni identifikacijski i autentifikacijski sustav) koji nudi različite vrste vjerodajnica. Za pristup 

elektroničkim uslugama Porezne uprave mogu se koristiti sljedeće vjerodajnice: 

✓ vjerodajnice niske sigurnosne razine (1) (npr. e-Građani ePass, ePošta, AAI@EduHr 

korisničko ime i lozinka) – omogućuju pristup ograničenom skupu usluga 

✓ vjerodajnice značajne sigurnosne razine (2) (npr. mToken za e-Građane, Fina Soft 

certifikat, token/m-token uređaji banaka koje su povezane sa sustavom e-Građani) – 

omogućuju pristup svim uslugama dostupnima građanima 

✓ vjerodajnice visoke sigurnosne razine (3) (npr. eOI - elektronička osobna iskaznica, Fina 

RDC - osobni certifikat ili AKD kID osobni certifikat) – omogućuju pristup svim uslugama 

dostupnima građanima.  

 

Ako je porezni obveznik korisnik sustava e-Građani, moći će se odmah koristiti uslugama 

dostupnima preko JPPU bez dodatne registracije. Prijava putem sustava e-Građani objašnjena je 

u korisničkom priručniku u poglavlju „Ulaz za građane“. 

Više informacija o sustavu e-Građani moguće je pronaći na sljedećoj Internet stranici: 

https://pretinac.gov.hr/KorisnickiPretinac/eGradani.html 

  

https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf
https://pretinac.gov.hr/KorisnickiPretinac/eGradani.html
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POSLOVNI KORISNICI 

Korisnik elektroničkih usluga Porezne uprave za poreznog obveznika može biti osoba ovlaštena 

za zastupanje poslovnog subjekta (direktor, vlasnik obrta, član uprave,..) ili posrednik ovlašten od 

strane poreznog obveznika (npr. knjigovodstveni servis). Korisnik aplikacije trebao bi ispuniti 

nekoliko preduvjeta za uspješno korištenje elektroničkih usluga Porezne uprave: 

✓ Posjedovanje čip kartice (engl. Smart Card) ili drugog medija za certifikate (USB token i 

sl.) AKD, FINA-e ili poslovnih banaka koji sadrže digitalne certifikate izdane od FINA 

RDC (registar digitalnih certifikata), eOI (HRIDCA, elektroničke osobne iskaznice), 

Certilia ili AKD (KIDCA). 

✓ Posjedovanje čitača čip kartice (ukoliko su certifikati pohranjeni na čip kartici) 

✓ Instalacija potrebnih softverskih komponenti za čitač čip kartice, USB-token ili dr. 

prema navodima proizvođača 

✓ Računalo barem minimalno preporučene konfiguracije 

✓ Registracija poslovnog subjekta u sustav JPPU. 

MINIMALNA KONFIGURACIJA RAČUNALA  

Minimalno preporučena konfiguracija stolnog ili prijenosnog računala za korištenje sustava jest: 

✓ CPU Intel Pentium IV 2 GHz ili procesor usporedivih karakteristika 

✓ 1024 MB radne (RAM) memorije 

✓ Grafički prikaz 1024x768 (u boji) 

✓ Operativni sustav Microsoft Windows 7 ili noviji.  

 

Aplikacija za svoj rad zahtijeva Internet preglednik. Podržani su sljedeći Internet preglednici: 

✓ Google Chrome v45.0 ili novija 

✓ Mozilla Firefox v57 ili novija 

✓ Opera v32 ili novija 

✓ Microsoft Edge v80.0 ili novija 

 

Podržane Java verzije: 

✓ Minimalna podržana verzija je Java 7u1 

✓ Nisu podržane verzije Java 7u25, 7u40 i 7u45 

✓ Za preglednike Google Chrome, Operu, Microsoft Edge i Mozilla Firefox napravljena je 

prilagođena komponenta koja ne koristi Javu za potpisivanje obrasca. 

Navedeni preduvjeti spadaju u uobičajenu programsku podršku na računalu i moguće da neće 

biti potrebno poduzimati dodatne radnje.  

Detaljne informacije o preduvjetima nalaze se u korisničkom priručniku.  

https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf
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DIGITALNI CERTIFIKATI 

Potpisivanje obrazaca i zahtjeva u aplikaciji JPPU izvršava se elektroničkim potpisom. Za 

elektronički potpis koriste se digitalni certifikati izdani od FINA-e, certifikati na elektroničkoj 

osobnoj iskaznici (AKD HRIDCA) ili komercijalni osobni certifikati (AKD KIDCA), a mogu biti izdani 

korisniku na čip kartici ili USB uređaju. Izuzetak su porezni obveznici koji dohodak i porez na 

dohodak utvrđuju u paušalnom iznosu te građani. Oni mogu obrasce i zahtjeve dostavljati s 

vjerodajnicom značajne sigurnosne razine (2) sukladno članku 63. stavku 4. i 5. Pravilnika o 

provedbi Općeg poreznog zakona (NN 45/19, 35/20, 43/20, 50/20, 70/20, 74/20, 103/20, 114/20, 

144/20, 2/21, 26/21, 43/21, 106/20, 144/21, 156/22, 16/25). Zahtjev za izdavanje/izmjenu PK 

(Porezne kartice) te Zahtjevi za izdavanje poreznih potvrda mogu se dostavljati s vjerodajnicom 

niske sigurnosne razine (1). 

 

FINA i AKD su certificirani pružatelji usluga certificiranja u RH registrirani kod Ministarstva 

gospodarstva. Za nabavu FINA certifikata potrebno je u FINA-i predati zahtjev za izdavanje 

digitalnih certifikata. Neke poslovne banke (RBA, Slatinska banka, OTP banka, PBZ banka i ZABA) 

na svojim čip-karticama ili drugim medijima za pohranu certifikata pored certifikata banke nude i 

opciju dodatnih certifikata FINA-e koji se mogu koristiti i za elektroničke usluge Porezne uprave.  

 

 

Nakon što korisnik preuzme digitalne certifikate potrebno je instalirati programsku podršku za 

čip-kartice ili USB key/tokene FINA-e ili poslovnih banaka prema dobivenim uputama. 

AKD certifikati izdaju se na elektroničkim osobnim iskaznicama u nadležnosti Ministarstvo 

unutarnjih poslova (MUP). Nakon preuzimanja elektroničke osobne iskaznice potrebno je izvršiti 

registraciju prema uputama MUP-a. AKD izdaje i komercijalne certifikate (osobne i poslovne) čije 

izdavanje se može zatražiti u AKD-u.  
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KAKO SE REGISTRIRATI  

Ako je porezni obveznik građanin, za ulaz u aplikaciju nije potrebna registracija. Potrebno je 

odabrati „Ulaz za građane“ nakon čega se korisnik preusmjerava na NIAS radi autentifikacije za 

ulazak u aplikaciju gdje prati upute za prijavu. 

Poslovni korisnici prije prvog korištenja sustava trebaju se registrirati te koriste jedan od dva 

načina: 

1. Registracija putem punomoći: omogućuje dodjelu ovlaštenja u slučaju kada porezni 

obveznik-opunomoćitelj nema mogućnost dodijeliti ovlaštenja elektroničkim putem, 

odnosno kada nema potrebno sredstvo za autentifikaciju (nema digitalni certifikat i nije 

registriran u sustavu). U tom slučaju potrebno je popuniti obrazac punomoći, vlastoručno 

ga potpisati od strane opunomoćitelja i opunomoćenika te dostaviti u ispostavu Porezne 

uprave. Obrazac punomoći može se popuniti putem web obrasca koji je dostupan na 

početnoj stranici unutar ulaza za poslovne subjekte pod opcijom „Registracija“ gdje je 

potrebno odabrati „Punomoć“. Obrazac punomoći dostupan je i na izravnoj poveznici: 

Ako popunjava opunomoćenik (traži se prijava certifikatom kojeg će opunomoćenik 

koristiti – podaci iz certifikata automatski će biti popunjeni na obrascu punomoći): 

https://e-porezna.porezna-uprava.hr/Punomoc.aspx?popunjavatelj=opunomocenik 

Ako popunjava opunomoćitelj:  

https://e-porezna.porezna-uprava.hr/Punomoc.aspx?popunjavatelj=opunomocitelj  

Ako se na punomoći odabere usluga „Upravljanje ovlaštenjima“, smatra se da je punomoć 

dana za najvišu razinu ovlaštenja koja omogućuje opunomoćeniku pregledavanje, 

ukidanje i dodjeljivanje ovlaštenja trećoj osobi za bilo koju uslugu ePorezna-JPPU, ali za 

taj isti poslovni subjekt. 

 

2. Zahtjev za registraciju: Zahtjev za registraciju u sustav podnosi isključivo odgovorna 

osoba u poslovnom subjektu za koju Porezna uprava (OIB sustav) nema podatak o 

zastupstvu i prema tome nije moguća automatska registracija i prijava u sustav ePorezna 

za poslovne subjekte gdje je odgovorna osoba. Napomena: prokurist ne može podnijeti 

Zahtjev za registraciju u sustav ePorezna. Zakonski zastupnik (odgovorna osoba) može 

prokuristi dodijeliti ovlaštenje (na NIAS vjerodajnicu) za korištenje sustava ePorezna kroz 

modul „Upravljanje ovlaštenjima“ ili putem obrasca punomoći. Porezni obveznik pred 

službenom osobom potpisuje ispunjeni Zahtjev u dva primjerka i isti predaje služenoj 

osobi. Porezni obveznik (podnositelj Zahtjeva) mora dokazati da je odgovorna osoba u 

poslovnom subjektu, donijeti na uvid, primjerice izvod iz sudskog registra. Zakonski 

zastupnik u udruzi mora priložiti status udruge ili bilo koji dokument, odluku i slično, iz 

kojeg je vidljivo zastupstvo. Službena osoba provjerava identitet poreznog obveznika i 

podatke u obrascu Zahtjeva te svojim potpisom i pečatom ovjerava da je Zahtjev 

https://e-porezna.porezna-uprava.hr/Punomoc.aspx?popunjavatelj=opunomocenik
https://e-porezna.porezna-uprava.hr/Punomoc.aspx?popunjavatelj=opunomocitelj
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zaprimljen. Službena osoba jedan ovjereni primjerak Zahtjeva predaje poreznom 

obvezniku, a jedan zadržava kod sebe. Porezni obveznik može ispunjeni Zahtjev poslati i 

putem pošte. U tom slučaju potreban je samo jedan primjerak Zahtjeva ovjeren od strane 

javnog bilježnika s priloženim dokazom da je porezni obveznik (podnositelj Zahtjeva) 

odgovorna osoba u poslovnom subjektu. Službena osoba po dodijeli ovlaštenja telefonom 

ili elektroničkom poštom (navedeno u Zahtjev) obavještava poreznog obveznika da su 

ovlaštenja dodijeljena. Porezni obveznik/korisnik putem elektroničke usluge „Upravljanje 

ovlaštenjima“ u aplikaciji može sam upravljati ovlaštenjima za svoj poslovni subjekt, 

dodjeljivati i ukidati ovlaštenja drugim korisnicima. Za Zahtjev za registraciju potrebno je 

na početnoj stranici odabrati opciju „Kako postati korisnik“, zatim odabrati opciju „Zahtjev 

za registraciju“. Zahtjev za registraciju dostupan je i na izravnoj poveznici:  

https://e-porezna.porezna-uprava.hr/Registracija.aspx.  

 

Postupci registracije objašnjeni su u korisničkom priručniku u poglavlju „Registracija“. 

KAKO RIJEŠITI PROBLEME U RADU APLIKACIJE JPPU 

U ovome poglavlju opisani su problemi tehničke prirode koji se mogu pojaviti pri korištenju 

sustava JPPU kao i načini njihova rješavanja. Poglavlje je podijeljeno na sljedeće dijelove: 

Ulaz u  – opis grešaka koje se mogu dogoditi pri ulazu u JPPU. 

Potpisivanje obrasca- opis grešaka koje se mogu dogoditi pri potpisivanju obrasca. 

Dohvat PKK - opis grešaka koje se mogu dogoditi pri dohvatu PKK. 

Upute u ovome dokumentu namijenjene su osobama s određenim informatičkim predznanjem o 

arhiviranju datoteka (Zip arhive), instalaciji aplikacija (middleware, Java i sl.), instalacija digitalnih 

certifikata, te ostalome navedenom u uputama.  Ako smatrate da ne možete uspješno slijediti 

navedene upute, obratite se Vašoj informatičkoj podršci. 

 

ULAZ U JPPU 

U ovome poglavlju navedena su rješenja problema koji se mogu pojaviti pri ulazu u aplikaciju 

JPPU. 

CERTIFIKAT NIJE PONUĐEN  PRI ULAZU U JPPU 

Pri ulazu u aplikaciju JPPU trebao bi se otvoriti dijaloški okvir za odabir certifikata kojim se želite 

prijaviti. Preduvjet je da se odgovarajući certifikat nalazi na mediju (kartica/USB token), da nisu 

istekli,  te da je certifikat instaliran s medija na računalo.  

Opis problema:  

https://e-porezna.porezna-uprava.hr/Registracija.aspx
https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf


JPPU Ministarstvo financija - Porezna uprava 

 

Često postavljena pitanja  Str. 12  

Pri ulazu u aplikaciju JPPU odgovarajući certifikat ne pojavljuje se na dijaloškom okviru za odabir 

certifikata. 

Rješenje: 

1. Zatvorite sve prozore Internet pretraživača.  

2. Uključite sve uređaje za digitalni potpis (kartice te USB tokene od FINA ili poslovnih banaka). 

Pokušajte ponovo. 

3. Pokušajte pristupiti s drugim Internet pretraživačem od onoga koji koristite (Internet Explorer, 

Google Chrome, Mozilla Firefox, Opera, Microsoft Edge) 

4. Provjerite jesu li certifikati instalirani na računalu: 

a. Otvorite „Internet Explorer > Tools > Internet options“. 

b. Odaberite karticu „Content“ te odaberite „Certificates“. 

c. Nakon što se otvori prozor s prikazom certifikata pod karticom "Personal" potražite da 

li se tamo nalaze vaša dva certifikata koja su vam potrebna za rad s aplikacijom JPPU.  

d. Obavezno provjerite polje „Expiration Date“ gdje je zapisano do kojeg datuma vrijede 

certifikati. Ako su istekli, potrebno ih je obnoviti. Za obnovu certifikata obratite se 

instituciji od koje ste preuzeli uređaj s certifikatima (Fina, poslovne banke). 

 
 

e. Ako ne vidite Vaš certifikat na način prikazan na slici, instalirajte certifikate s medija 

(kartica/USB token) na način naveden u poglavlju Instalacija certifikata na računalo  

 

„NIJE ODABRAN CERTIFIKAT“  

 

Opis problema:  

 

prilikom prijave u aplikaciju (nakon odabira certifikata) ne pojavljuje se dijaloški okvir za unos PIN-

a, već se pojavi poruka „Nije odabran certifikat“.  
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Mogući uzroci: 

 

A. Certifikat je na računalu, no medij (kartica/USB token) nije uključen. 

B. Odabran je certifikat no pogrešan medij (kartica/USB token) je u računalu. 

C. Na mediju (kartica/USB token) nema potrebnog certifikata. Moguće kako su greškom 

obrisani s medija, a ranije su se nalazili na njemu. 

D. Moguće da je certifikat istekao. 

E. Ako se greška događa samo u Mozilla Firefox pretraživaču, rješenje se nalazi u poglavlju 

Podešavanje Mozzila Firefox za rad sa smart karticom / USB KEy-em.  

 

Rješenje: 
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1. Zatvorite sve prozore Internet pretraživača. 

2. Izvadite sve medije s digitalnim certifikatima (kartica/USB token).  

3. Uključite u računalo samo onaj uređaj koji želite koristiti za potpis. Otvorite Internet pretraživač 

te pokušajte ponovo pristupiti stranici JPPU.  

4. Odaberite Vaš certifikat.  

5. Ako prilikom prijave nemate ponuđen certifikat, potrebno je provesti upute iz poglavlja 

„CERTIFIKAT NIJE PONUĐEN PRI ULAZU U APLIKACIJU JPPU“ 

6. Ako Vas nakon odabira certifikata upita za unos PIN-a i nakon unosa se pojavi greška „Nije 

odabran certifikat“, greška može biti u softveru za uređaj za digitalni potpis (middleware). U 

tom slučaju napravite reinstalaciju softvera (ActivClient, eTokenPKI Client, Sophos 

Authentication Client, IDPrime, Device Client, AKDeID) prema uputama koje ste dobili uz Vaš 

medij s digitalnim certifikatom. 

7. Provjerite pita li Vas za PIN! U ovome trenutku Vaš softver za korištenje medija za potpis trebao 

bi otvoriti dijaloški okvir za unos PIN-a. Ako se ne pojavi prozor za unos PIN-a i naiđete na 

grešku „Nije odabran certifikat“, potrebno se javiti instituciji od koje ste podigli uređaj (Fina ili 

neka od poslovnih banaka) kako bi oni provjerili certifikate na uređaju za potpis te sam uređaj. 

 

Ponekad prilikom snimanja certifikata na medij (kartica/USB token) može doći do greške, te uz 

certifikate koji bi trebali biti na kartici bude snimljen i dodatni certifikat s greškom naziva „RSA 

Key Pair“. Kako bi provjerili imate li samo ispravne certifikate na mediju otvorite aplikaciju 

ActivClient i dva puta kliknite na „My Certificates“. 

 

 
 

U mapi „My Certificates“ trebali bi se nalaziti samo dva certifikata koja glase na ime i prezime 

osobe na koju su izdani. Ako se uz ove certifikate nalazi i certifikat „RSA Key Pair“, obratite se 

izdavatelju certifikata (Fina ili poslovne banke) i zatražite brisanje i novo izdavanje certifikata na 

uređaj. 
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„THE PAGE CANNOT BE DISPLAYED“ ILI „INTERNET EXPLORER CANNOT DISPLAY THIS 

WEB PAGE“ ILI „THIS WEBPAGE IS NOT AVAILABLE“ 

Poruka se pojavljuje prilikom ulaza u aplikaciju nakon odabira certifikata. Ako se prije ove poruke 

ne pojavi dijaloški okvir za unos PIN-a Vaše kartice, za rješenje pogledajte prethodno poglavlje 

„Nije odabran certifikat“ i moguće uzroke pojavljivanja problema.  

Ako se pojavi dijaloški okvir za unos PIN-a i nakon unosa naiđete na ovu grešku, napravite 

sljedeće:  

Rješenje 

1. Ugasite sve Internet preglednike 

2. Isključite karticu/stick iz računala 

3. Otvorite Activ Client aplikaciju.(Start—All programs—ActivIdentity—ActivClient—User 

Console) 

4. Uključite karticu/stick u računalo. 

5. U ovom trenutku treba se pojaviti dijaloški okvir za unos PIN-a 

(Ako se dijaloški okvir nije pojavio, pokušajte ponovo isključiti karicu/stick iz računala te ju 

ponovo uključiti. Ukoliko se dijaloški okvir nakon nekoliko pokušaja ne pojavljuje, 

preporuka je reinstalirati program Activ Client i instalirati odgovarajuću verziju za 

operativni sustav koji koristite. (Za pomoć oko reinstalacije podrške za rad s certifikatima 

potrebno se obratiti izdavatelju od kojeg ste zakupili certifikate). 

6. Dijaloški okvir za unos PIN-a možete i prisilno otvoriti promjenom zadanog certifikata. U 

mapi My Certificates desnim klikom miša nad jednim od prikazanih certifikata otvorite 

prikaz opcija koje se mogu obaviti nad odabranim certifikatom. Zatim odaberite opciju 

“Set this as default certificate”. 
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7. Ako se pojavio dijaloški okvir za unos PIN-a i  uspješno ste ga unijeli, pokušate tada otvoriti 

Internet preglednik, pristupiti stranicama JPPU aplikacije te se prijaviti u JPPU aplikaciju. 
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„S IZABRANIM CERTIFIKATOM NIJE MOGUĆE IZVRŠITI REGISTRACIJU “ 

 

 

 

Opis problema: 

Na vašem mediju za potpis (kartica/USB token) nalazi se certifikat koji u sebi ne sadrži OIB 

poslovnog subjekta te OIB korisnika (koristite digitalne certifikate izdane prije 11.3.2013 ili je 

certifikat neispravno izdan. Digitalni certifikati izdani nakon 11.3.2013. sadrže navedene OIB-ove i 

s njima se može napraviti registracija odabirom „Registriraj me“. Vaš certifikat ne može se 

automatski registrirati, već je potrebno napraviti sljedeće: 

1. Pokušajte otvoriti aplikaciju odabirom gumba „Prijava“. Ako se možete prijaviti u aplikaciju 

i vidjeti module (obrasci, postavke, pregled podataka, upute,.. ), nije potrebno (niti 

moguće) napraviti registraciju. 

2. Ako se odabirom gumba prijava pojavi poruka „Poštovani, nemate potrebna ovlaštenja za 

ulazak u aplikaciju JPPU“, pogledajte rješenje u sljedećem naslovu „Nemate potrebna 

ovlaštenja za ulazak u aplikaciju JPPU“. 

3. Ako certifikat kojim se pokušavate registrirati glasi na ovlaštenu osobu (direktor, vlasnik 

obrta, član uprave,..), pokušali ste se s njime prijaviti (odabirom gumba „Prijava“) i niste 

uspjeli izvršiti registraciju, problem prijavite putem web obrasca „Pišite nam“(klikni ovdje) 

i odaberite podtemu „Ovlaštenja“ 

 

 „NEMATE POTREBNA OVLAŠTENJA ZA ULAZAK U APLIKACIJU JPPU“ 

 

 

 

Ako niste porezni obveznik koji se u svoje ime koristi aplikacijom ili ovlaštena osoba za 

zastupanje poslovnog subjekta (direktor, član uprave, vlasnik obrata, ..), obavezna je registracija 

popunjavanjem elektroničkog obrasca punomoći (korisnički priručnik, poglavlje „Popunjavanja 

elektroničkog obrasca punomoći“) ili predajom obrasca punomoći u ispostavu PU. Dakle nije 

moguća registracija direktno putem aplikacije JPPU.  

Ako jeste porezni obveznik koji se u svoje ime koristi aplikacijom ili osoba ovlaštena za 

zastupanje poslovnog subjekta, odaberite gumb „Ulaz za poslovne korisnike“, zatim gumb 

„Registracija“.  

Registracija putem aplikacije objašnjena je u korisničkom priručniku u poglavlju „Registracija“ 

https://pisitenam.porezna-uprava.hr/
https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf
https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf


JPPU Ministarstvo financija - Porezna uprava 

 

Često postavljena pitanja  Str. 18  

Ako ste predali obrazac punomoći, a i dalje dobivate poruku da nemate potrebna ovlaštenja za 

ulazak u aplikaciju JPPU, problem prijavite putem web obrasca „Pišite nam“(klikni ovdje) i 

odaberite podtemu „Ovlaštenja“ 

 

POTPISIVANJE OBRASCA 

U ovome poglavlju navedena su rješenja problema koji se mogu pojaviti prilikom potpisivanja 

obrazaca. 

„OBRAZAC NIJE DIGITALNO POTPISAN“  

 

 

 

Opis problema:  

Nakon odabira gumba „Potpiši“ pojavljuje se poruka za preuzimanje nove verzije Java-e. 

 

Uzrok: 

Na računalu nije instalirana Java ili nije instalirana potrebna verzija Jave – npr. instalirana je 64bit 

Java, a koristite se 32bit Internet pretraživačem. 

Rješenje: 

1. Zatvorite sve Internet preglednike. 

2. Uklonite (deinstalirajte) sve verzije Java-e na računalu prema uputama u poglavlju Kako 

ukloniti Java softver s računala. 

3. Instalirajte Javu prema uputama u poglavlju Instalacija Jave. 

https://pisitenam.porezna-uprava.hr/
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4. Omogućite Javu na računalu na način opisan u poglavlju Kako omogućiti Javu u Internet 

preglednicima  

5. Pokušajte ponovo. Ako naiđete na isti problem pri potpisivanju, pokušajte u drugome 

Internet pregledniku (Internet Explorer, Google Chrome, Microsoft Edge ili Mozilla Firefox). 

„CERTIFIKAT ZA POTPISIVANJE NIJE POSTAVLJEN“  

 

Opis problema: 

Nakon odabira gumba „Potpiši“ odmah se pojavi poruka „Certifikat za potpisivanje nije 

postavljen“. 

Uzrok i rješenje: 

Ako se poruka „Certifikat za potpisivanje nije postavljen“ pojavi odmah nakon odabira gumba 

„Potpiši“ (dakle prije poruke ne pojavi se ekran „Molim pričekajte…“), greška je u Java preduvjetu. 

U tom slučaju napravite sljedeće: 

1. Zatvorite sve Internet preglednike. 

2. Uklonite (deinstalirajte) sve Java verzije na računalu. 

3. Instalirajte Javu prema uputama u poglavlju Instalacija Jave. 

4. Omogućite Javu na računalu na način opisan u poglavlju Kako omogućiti Javu u Internet 

preglednicima. 

5. Pokušajte ponovo. Ako naiđete na isti problem pri potpisivanju, pokušajte u drugome 

Internet pregledniku (Google Chrome, Microsoft Edge, Mozilla Firefox ili Opera).  

 

NAPOMENA : Ako se prvo pojavi ekran „Molim pričekajte…“, a tek nakon njega poruka 

„Certifikat za potpisivanje nije postavljen“, Java je ispravno instalirana. U tom slučaju uzrok 

problema može biti na mediju (kartica/USB token).  
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Provjerite sljedeće:  

 

U računalo uključite samo medij (kartica/USB token) s kojim želite potpisati obrazac, sve ostale 

medije isključite. Pokušajte ponovo potpisati.  

Ako se greška ponovi, potrebno je provjeriti ispravnost certifikata na mediju provjerom u jednoj 

od sljedećih aplikacija: ActivClient, eToken PKI Client te Safenet Authentication Client. Napomena: 

Porezna uprava ne pruža podršku za dolje navedene aplikacije. Ovo su informativni podaci kako 

bi mogli provjeriti nalazi li se uzrok problema na mediju. Za detaljnu provjeru potrebno je obratiti 

se instituciji (Fina ili poslovna banka) od koje ste preuzeli Vaš medij (kartica/USB token). 

 

ActivClient 

1. Otvorite Active Client aplikaciju odabirom „Start > All Programs > Active Identity > Active 

Client > User Console”. 

2. Kod pregleda certifikata u mapi My Certificates provjerite postoji li Rsa Key Pair uz Vaša 

dva certifikata koji glase na ime i prezime (kao na slici dolje). Ukoliko postoji, to je uzrok 

greške. 

3. Rješenje: Potrebno se javiti Fina-i ili poslovnoj banci koja Vam je izdala uređaj kako bi 

pobrisali RSA Key Pair – odnosno nepotpuni podatak koji je nastao prilikom snimanja 

certifikata na medij, a stvara greške pri potpisivanju.  

  

 
 

 

eToken PKI Client 

1. Otvorite eToken PKI Client aplikaciju odabirom „Start > All Programs > eToken > eToken 

PKI Client > eToken Properties“ 
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2. Odaberite Advanced View  

U popisu certifikata s lijeve strane odaberite User Certificates. U ovome polju trebaju se 

nalaziti samo dva certifikata s Vašim imenom, prezimenom i brojem certifikata, te jedan 

certifikat koji u nazivu sadrži Vaš OIB. Ako se uz ovo nalazi i neki drugi certifikat (RSA 

Private Key, RSA Key Pair,..), on je uzrok greške. 

3. Otvorite i mapu Orphan Objects te provjerite nalazi li se u njoj još neki certifikat osim RDC 

(kao na slici dolje). Dodatni certifikati u ovoj mapi također mogu biti uzrok greške. 

4. Rješenje: Potrebno je javiti se FINA-i odnosno poslovnoj banci koja Vam je izdala uređaj 

kako bi pobrisali RSA Private Key – odnosno nepotpuni podatak koji je nastao prilikom 

snimanja certifikata na medij, a stvara greške pri potpisivanju.  

 
 

Safenet Authentication Client 

1. Otvorite eToken PKI Client aplikaciju odabirom „Start > All Programs > eToken > eToken 

PKI Client > eToken Properties“ 

2. Odaberite Advanced View  

U popisu certifikata s lijeve strane otvorite User Certificates. U ovome polju trebaju se 

nalaziti samo dva certifikata s Vašim imenom, prezimenom i brojem certifikata, te jedan 

certifikat koji u nazivu sadrži Vaš OIB. Ako se uz ovo nalazi i neki drugi certifikat (RSA 

Private Key, RSA Key Pair,..), on je uzrok greške. 

3. Otvorite i mapu Orphan Objects te provjerite nalazi li se u njoj još neki certifikat osim RDC 

(kao na slici dolje). Dodatni certifikati u ovoj mapi također mogu biti uzrok greške. 

4. Rješenje: Potrebno je javiti se FINA-i odnosno poslovnoj banci koja Vam je izdala uređaj 

kako bi pobrisali RSA Private Key – odnosno nepotpuni podatak koji je nastao prilikom 

snimanja certifikata na medij, a stvara greške pri potpisivanju.  
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 „NE POSTOJI NITI JEDAN ODGOVARAJUĆI CERTIFIKAT “ 

 

  

 

 

 

Opis problema:  

Nakon odabira gumba „Potpiši“ pojavi se poruka Ne postoji niti jedan odgovarajući certifikat. 

Nakon toga pojavi se poruka Certifikat za potpisivanje nije postavljen.  

Uzrok: 

A. Na mediju (kartica/USB token) ne postoje adekvatni certifikati za potpis.  

B. Koristite više uređaja na kojima su certifikati istovremeno u računalu. 

C. Koristite verziju stariju verziju ActivClient aplikacije.  

D. Također, moguće je kako se na mediju (kartica/USB token) nalaze potrebni certifikati, no 

uz njih nalazi se i dodatni certifikat s greškom koji stvara problem.  

Rješenje: 

1. Provjerite imate li uključen samo uređaj (Smart kartica/USB token) na kome se nalaze 

certifikati izdani za korištenje elektroničkih usluga Porezne uprave. 

2. Provjerite verziju Activ Client aplikacije. 

3. Ako ste sigurni kako je ispravan uređaj uključen i imate ispravnu verziju Activ Client 

aplikacije, za pomoć se obratite instituciji (Fina ili poslovna banka) od koje ste podigli Vaš 

uređaj kako bi provjerili certifikate na mediju (kartica/USB token) te eventualno ponovo 

snimili certifikate na uređaj. Moguće kako se uređajem uspješno služite u drugim 

aplikacijama, no na uređaju se ne nalaze certifikati potrebni za JPPU sustav. 
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„NE POSTOJI AKTIVAN ČITAČ“  

 

Opis problema:  

Pri potpisivanju obrazaca javlja se poruka „Molimo pričekajte…“ te nakon toga poruka „Ne postoji 

aktivan čitač“ iako je medij za potpisivanje (kartica/USB token) uključen u računalo. Greška može 

nastati iz razloga što datoteke Active Client aplikacije nisu instalirane na ispravnoj lokaciji na 

računalu. Kako bi ispravili grešku slijedite upute:  

1. Otvorite „Control Panel > Programs & Features“ >odaberite ActivClient > odaberite 

„Uninstall“ i slijedite upute. 

2. Ponovo pokrenite računalo (engl. restart). 

3. Otvorite Programe i značajke odabirom „Control Panel > Programs & Features“. 

4. Potražite nalazi li se Active Client aplikacija na popisu (ne bi se više smjela nalaziti) 

5. Provjerite nalazi li se Acitiv Card Gold aplikacija na popisu. Ako se nalazi, izvršite deinstalaciju 

odabirom „Activ Card Gold“ i zatim „Uninstall“. Ponovo pokrenite računalo. 

6. Otvorite mapu „Computer > Local disk (C:) > Program Files“. 

7. Pretražite postoji li mapa „ActivIdentity“. Ako postoji, izbrišite istu. 

8. Na istoj lokaciji potražite mapu „Activ Card“. Ako postoji, izbrišite istu. Napomena: Na 

računalu se mogu nalaziti mape „C:\Program Files“ i „C:\Program Files (x86)“. Korake 7 i 8 

ponovite u obje lokacije. 

9. Pokrenite skidanje instalacije ActivClient aplikacije s linka: http://rdc.fina.hr/download/fina-

install.zip 

10. Raspakirajte skinuti dokument i pokrenite instalaciju odabirom „Launch“. Slijedite upute 

kako bi dovršili instalaciju. 

11. Vrlo bitno: ne mijenjajte ponuđenu lokaciju (mapu) za instalaciju - greška će se ponoviti ako 

se odabere mapa različita od one ponuđene. 

10.Ponovo pokrenite računalo (engl. restart). 

11.Pokušajte potpisati obrazac. 

12. Ako navedeno rješenje nije pomoglo, svakako pokušajte s deinstalacijom i zatim instalacijom 

druge verzije programske podrške (Activ Client) namijenjene vašem operativnom sustavu. 

  

http://rdc.fina.hr/download/fina-install.zip
http://rdc.fina.hr/download/fina-install.zip
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EKRAN SE ZAMRZNE NA PORUCI „MOLIM PRIČEKAJTE…“  

 

 

Opis problema:  

Nakon potpisivanja obrasca (gumb „Potpiši“) duže vrijeme (preko 5 minuta) se vrti animacija za 

potpisivanje, no obrazac se nikada ne potpiše. Ekran Internet pretraživača se može „zamrznuti“, 

odnosno ne reagirati na pokušaj zatvaranja. 

Uzrok A: 

Računalo pristupa na Internet putem Proxy poslužitelja, no postavke Proxy poslužitelja nisu 

ispravno namještene u Java aplikaciji. 

Rješenje A: 

1. Otvorite Start izbornik, odaberite „Control Panel > Java“. U Java prozoru otvorite karticu 

General, a zatim odaberite „Network Settings…“. U novom prozoru odaberite „Use browser 

settings“.   

2. Ako se greška ponavlja, upišite postavke Proxy servera odabirom „Use Proxy Server“. Za 

točne postavke obratite se osobi koja održava Vaše računalo i poslužitelje. 
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Uzrok B. 

Greška se može dogoditi ako na jednom računalu koristite dva ili više uređaja za potpisivanje, 

odnosno na računalu se nalaze dva softvera za medije s digitalnim certifikatima (kartica ili USB 

token). Problem se na primjer može javiti ako koristite ActivClient softver zajedno uz eToken PKI 

Client softver.  

Rješenje B: 

1. Napravite reinstalaciju programske podrške za rad vaših certifikata 

2. Prije potpisivanja umetnite samo medij (kartica/USB token) kojim se želite koristiti za 

digitalni potpis. Zatvorite sve prozore Internet pretraživača, ponovo otvorite pretraživač i 

pokušajte ponovo. 

 

Uzrok C. 

Računalo ima aktivnu VPN konekciju što onemogućuje potpisivanje. 

Rješenje C: 

Privremeno isključite VPN konekciju kako bi mogli potpisati i poslati obrazac. 

 

UČITAVANJE JOPPD OBRASCA 

TIPKE „ODABERITE DATOTEKU“ I „UČITAJ“ NISU AKTIVNE  

 

  

UZROK: 

 

U slučaju da ste stavili adresu aplikacije e-porezna u zonu „Trusted sites“, neće raditi forma za 

dostavu datoteke (gumbi će biti zasivljeni).  

  

RJEŠENJE: 

 

Ukloniti adresu aplikacije e-porezna iz zone „Trusted Sites“. Za normalan rad dovoljna je i Internet 

zona u koju se automatski smješta aplikacija ukoliko nije dodana u druge zone. 

  

Podešavanje zona nalazi se u Tools/Internet Options : 

  



JPPU Ministarstvo financija - Porezna uprava 

 

Često postavljena pitanja  Str. 26  

 
  

Uklanjanje iz Trusted Sites: Kliknuti na ikonu „Trusted Sites“, zatim na gumb „Sites“: 

 

 
  

Odabrati adresu aplikacije i zatim kliknuti na gumb Remove pa Close. Na idućem prozoru kliknuti 

OK. 
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DOHVAT PKK 

U ovome poglavlju navedena su rješenja problema koji se mogu pojaviti pri dohvatu Porezno 

knjigovodstvene kartice. 

"GREŠKA PRILIKOM DOHVATA POREZNO KNJIGOVODSTVENE KARTICE. MOLIMO 

POKUŠAJTE KASNIJE"  

Trenutno ne postoje podaci na traženoj porezno knjigovodstvenoj kartici. 

 

UPUTE  

JAVA 

PROVJERA VERZIJE JAVE 

Preduvjet za korištenje JPPU aplikacije u Internet Explorer pregledniku je instalirana odgovarajuća 

verzija Java-e na računalu. Na sljedeći način možete provjeriti imate li potrebnu verziju Java 

programa na Vašem računalu: 

Otvorite „Upravljačku ploču“ (engl. Control panel) 
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Odaberite „Programi  i značajke“ (engl. Programs and features), odaberite Java: 

 

 

Za provjeru verzije instalirane Jave potrebno je klikom na ikonu Java otvoriti prozor konfiguracije 

(može izgledati drugačije, ovisno o verziji operativnog sustava). Ako ne možete pronaći „Java“ u 

Control Panel prozoru, napravite instalaciju Java preduvjeta prema uputama u poglavlju Instalacija 

Jave. 

 

Odaberite „About…“ kako bi otvorili prozor s informacijama o verziji Java-e. 
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Ako je instalirana niža verzija od preporučene za Vaš operativni sustav, preporučamo instalaciju 

nove verzije Java (opisano u sljedećem poglavlju). 

INSTALACIJA JAVE 

Detaljne informacije o podržanim verzijama Java preduvjeta provjerite u poglavlju „MINIMALNA 

KONFIGURACIJA RAČUNALA“  

Kako bi instalirali  odgovarajuću verziju Java preduvjeta napravite sljedeće: 

U Vašem Internet pretraživaču otvorite adresu http://www.java.com/   

  

Odaberite „Agree and Start Free Download“. 

http://www.java.com/en/download/index.jsp
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Odaberite „Install“ kako bi pokrenuli instalaciju Java-e. 

 

  

Odaberite „Close“ kako bi završili proces instalacije Java preduvjeta na Vašem računalu. 
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KAKO OMOGUĆITI JAVU U INTERNET PREGLEDNICIMA  

Upute kako omogućiti Java preduvjet kojim se aplikacija JPPU koristi pri potpisivanju u podržanim 

Internet preglednicima. 

Internet Explorer 

1. Odaberite „Tools > Internet Options“. 

2. Otvorite karticu „Security“, kliknite na gumb „Custom Level“. 

3. Pronađite u popisu Scripting of Java applets. 

4. Provjerite da je označeno Enable, odnosno je li Java omogućena. 

5. Kliknite „OK“ kako bi spremili izmjene. 

6. Isključite sve Prozore Internet Explorer preglednika te ponovo pokrenite Internet Explorer i 

pokušajte ponovo potpisati obrazac. 

7. Internet Explorer će u jednom trenutku prikazati traku s porukom This website wants to run 

the following add-on:'Java SE 7 Runtime Enviroment 7 Update XX' from Oracle…if you trust this 

web site and the add-on and want to allow it to run, click here… 

8. Obavezno kliknite na ovu poruku. U slučaju da to ne napravite neprestano će Vam se nuditi 

instalacija Jave. 

9. Ako se pojavi prozor s porukom: Do you want to run this application? odaberite opciju "Always 

trust content from this publisher" te potom kliknite na gumb s natpisom "Run". Java se neće 

pokrenuti ako ne napravite ovaj postupak. 

 

ŠTO NAPRAVITI AKO SE JAVA STALNO POKUŠAVA INSTALIRATI  

Opis problema:  

Java se nakon instalacije iznova pokušava instalirati na računalo.  

Rješenje: 

Internet Explorer  

Internet Explorer će u jednom trenutku prikazati traku s porukom  This website wants to run the 

following add-on:'Java SE 7 Runtime Enviroment 7 Update XX' from Oracle…if you trust this web 

site and the add-on and want to allow it to run, click here… 

Kliknite na poruku označenu strelicom (nemojte kliknuti „Ok“ ili „Cancel“).  

  

 

Može se pojaviti i sljedeća poruka gdje je potrebno odabrati „Allow“. 
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Pri potpisivanju obrasca pojaviti će se sljedeća poruka: 

 

Odaberite „Do not show this again for apps from the publisher and location above“, a 

zatim „Run“ 
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ŠTO NAPRAVITI AKO STE U JEDNOM TRENUTKU BLOKIRALI POKRETANJE JAVE  

 

 

 

Ako ste na ekranu slučajno odabrali opciju „Block“ i time blokirali daljnje pokretanje Jave na 

vašem računalu, potrebno je ponovno omogućiti Javu. 

  

Javu ćete omogućiti na sljedeći način: 

 

 

Otvorite „Control Panel“ te među opcijama pronađite opciju Java ili Java (32-bit). 
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Odaberite karticu „Security“ te zatim odaberite potvrdi okvir „Enable Java content in the 

browser“. Potvrdite promjene odabirom gumba „OK“ 

  

  

 
  

  

Ponovno otvorite preglednik, prijavite se u aplikaciju te ovaj put pritisnite „LATER“ u poruci. 

 

Napomena: 

 

Ako ne želite više da vas Java podsjeća na novu nadogradnju Jave, odaberite potvrdi okvir „Do 

not ask again until the next update is available“.  Tom opcijom Java više neće zahtijevati 

nadogradnju sve do izlaska nove verzije.  

 

KAKO UKLONITI JAVA SOFTVER S RAČUNALA 

Ako želite ukloniti Java softver s računala, potrebno je napraviti sljedeće: 

1. Otvorite „Control Panel > Programs and Features“  

2. U popisu instaliranog softvera pronađite i klikom miša odaberite „Java x.xxxx“ (Npr. u 

popisu piše „Java 8u40“) te odaberite gumb „Uninstall“. Ako u popisu softvera pronađete 

Java 6.xx, ove verzije nemojte ukloniti kako bi njihovo uklanjanje utjecalo na rad ostalih 

aplikacija na računalu. 

3. Ponovite postupak uklanjanja za svaku pronađenu verziju Java x.xxxx. 

 

 

PREGLEDNICI KOJI NE KORISTE JAVA-U 

Ako koristite Google Chrome, Opera, Microsoft Edge ili Mozilla Firefox preglednik, za te 

preglednike potrebno je instalirati programsku podršku. 

Upute za instalaciju programske podrške nalaze se u korisničkom priručniku. 

 

 

https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Korisni%C4%8Dki%20priru%C4%8Dnik.pdf


JPPU Ministarstvo financija - Porezna uprava 

 

Često postavljena pitanja  Str. 35  

SOFTVERSKE KOMPONENTE ZA KARTICU/USB TOKEN (MIDDLEWARE)  

 „ACTIVCLIENT“ 

U ovome djelu opisane su upute za instalaciju podrške za karticu/USB token. 

1. Kako bi pokrenuli skidanje instalacije za ActivClient 7.02 otvorite ovaj link u Internet 

pretraživaču  

http://rdc.fina.hr/download/fina-install.zip  

2. Instalaciju raspakirajte na računalo te iz raspakirane mape pokrenite instalaciju pokretanjem 

aplikacije Launch. Slijedite upute na ekranu te dovršite instalaciju ActivClient softvera. 

3. Ponovo pokrenite računalo (engl. restart). 

„IDPRIME GEMALTO“ 

Programsku podršku i upute za instalaciju „IDPRIME GEMALTO“ programske podrške možete 

pronaći na stranicama izdavatelja usluge. Stranicama izdavatelja usluge možete pristupiti ovdje. 

„E-TOKEN AUTHENTICATION CL IENT“ ILI „SAFENET AUTHENTICATION CLIENT“ 

Programsku podršku i upute za instalaciju „E-TOKEN AUTHENTICATION CLIENT“ ili „SAFENET 

AUTHENTICATION CLIENT“ programske podrške možete pronaći na stranicama izdavatelja 

usluge. Također, za probleme prilikom instalacije certifikata na računalo potrebno se obratiti 

pružatelju usluga digitalnih certifikata. 

SOFTVER ZA UPRAVLJANJE DIGITALNIM CERTIFIKATIMA NIJE INSTALIRAN NA 

ZADANU (DEFAULT) LOKACIJU 

Ako softver za upravljanje digitalnim certifikatima (u nastavku: middleware) nije instaliran u 

zadanu (default) mapu već je pri instalaciji odabrana druga mapa, mogu se javiti problemi pri 

potpisivanju obrazaca. Kako bi omogućili aplikaciji ePorezna da potpiše obrazac koristeći 

middleware softver napravite jedno od sljedećih rješenja. 

RJEŠENJE A. - KOPIRANJE DLL-A ZA POTPISIVANJE U ZADANU MAPU 

Ovisno o middleware softveru te operativnom sustavu (x32 ili x64), potrebno je kopirati određene 

.dll dokumente iz mape u kojoj se nalazi middleware u mapu navedenu u tablici dolje. Mapa u 

koju treba kopirati dokumente ne postoji, potrebno ju je izraditi prije kopiranja. 

Middleware  Operativni sustav  Datoteke za kopiranje Gdje kopirati .dll dokumente 

ActivClient_7_02 X64 X64 acpkcs211.dll  C:\Program Files\HID Global\ActivClient  

ActivClient_7_02 X86 X86 acpkcs211.dll C:\Program Files (x86)\HID Global\ActivClient 

ActivClient_7_02 X64 X64 acpkcs211.dll C:\Program Files (x86)\ActivIdentity\ActivClient 

ActivClient_7_02 X86 X86 acpkcs211.dll C:\Program Files\ActivIdentity\ActivClient 

ActivClient 6.2 X64 X64 acpkcs201.dll 

acpkcs201-ns.dll 

acpkcs201-en6.dll 

acpkcs211.dll 

C:\Program Files\ActivIdentity\ActivClient\ 

http://rdc.fina.hr/download/fina-install.zip
http://www.fina.hr/Default.aspx?sec=1706
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ActivClient 6.2 X86 X64 acpkcs201.dll 

acpkcs201-ns.dll 

acpkcs201-en6.dll 

acpkcs211.dll 

C:\Program Files(x86)\ActivIdentity\ActivClient\ 

ActivClient 6.2 X86 X86 acpkcs201.dll 

acpkcs201-ns.dll 

acpkcs201-en6.dll 

acpkcs211.dll 

C:\Program Files\ActivIdentity\ActivClient\ 

Athena x64 X64 asepkcs.dll C:\Windows\System32 

Athena x32 X32 asepkcs.dll C:\Windows\System32 

ADK X64 X64 AkdEidPkcs11.dll 

AkdEidPkcs64.dll 

C:\Program Files\AKD\eID Middleware\pkcs11 

IDPrime X64 X64 IDPrimePKCS11.dll C:\Program Files (x86)\IDPrimeClient 

IDPrime X86 X86 IDPrimePKCS11.dll  C:\Windows\System32 

IDGo800 X64 X64 idprimepkcs11.dll C:\Program Files (x86)\Gemalto\IDGo 800 PKCS#11 

Safenet Auth. Client X86  X86 eTPKCS11.dll C:\Windows\SysWOW64\ 

Safenet Auth. Client X64 X64 eTPKCS11.dll C:\Windows\System32\ 

eToken PKI Client X86 X86 eTPKCS11.dll C:\Windows\SysWOW64\ 

eToken PKI Client X64 X64 eTPKCS11.dll C:\Windows\System32\ 

Primjer: 

Kao primjer uzeti ćemo ActivClient 6.2 x32 middleware koji je instaliran u mapu „C:\Programi\ 

ActivClient“ umjesto u zadanu (engl. default) mapu „C:\Program Files\ ActivIdentity\ ActivClient“. 

Na računalu se nalazi x32 operativni sustav. Potrebno je kopirati dokumente acpkcs201.dll, 

acpkcs201-ns.dll, acpkcs201-en6.dll te acpkcs211.dll iz mape „C:\Programi\ActivClient“ u mapu iz 

tablici.  

- Ako koristimo ActivClient 6.2 x32 te x32 operativni sustav dll-ove treba kopirati u mapu 

„C:\Program Files\ActivIdentity\ActivClient\“.  

- Prije kopiranja mapu „C:\Program Files\ActivIdentity\ActivClient“ treba izraditi jer se 

ona ne nalazi na računalu.  

- Otvorite „C:\Program Files“. Stvorite novu mapu (engl. new folder) imena 

„ActivIdentity“. Otvorite mapu „ActivIdentity“ i unutar nje stvorite mapu imena 

„ActivClient“. 

- Unutar mape „ActivIdentity“ kopirajte potrebne dll-ove. 

 

RJEŠENJE B. – IZMJENA „INIT.TXT“ DOKUMENTA 

1. Otvorite Notepad aplikaciju odabirom „Start > All Programs > Accessories > Notepad“ 

2. U Notepad-u kliknite na „File >Open…“ 

3. Upišite „C:\Users\user\AppData\Local\Temp\pkcs11\init.txt“ Napomena: umjesto user 

upišite ime korisničkog računa koji koristite. 

4. Provjerite u tablici dolje koju kombinaciju middleware-a i operativnog sustava koristite 

kako bi znali koji dll upisati. 

5. U otvorenom dokumentu upišite putanju do lokacije na kojoj je instalirana aplikacija 

ActivClient, odnosno potreban dll. 

6. Odaberite „File > Save“ kako bi pohranili izmjene. 
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Middleware  Operativni sustav  Upišite putanju do navedenog dll-a  

ActivClient_7_1 X64 X64 acpkcs211.dll  

ActivClient_7_1 X86 X86 acpkcs211.dll 

ActivClient_7_02 X64 X64 acpkcs211.dll 

ActivClient_7_02 X86 X86 acpkcs211.dll 
ActivClient 6.2 X64 X64 acpkcs211.dll 
ActivClient 6.2 X86 X64 acpkcs211.dll 
ActivClient 6.2 X86 X86 acpkcs211.dll 
Athena x64 X64 asepkcs.dll 
Athena x32 X32 asepkcs.dll 
ADK X64 X64 AkdEidPkcs11.dll 
IDPrime X64 X64 IDPrimePKCS11.dll 
IDPrime X86 X86 IDPrimePKCS11.dll 
IDGo800 X64 X64 idprimepkcs11.dll 
Safenet Auth. Client X86  X86 eTPKCS11.dll 
Safenet Auth. Client X64 X64 eTPKCS11.dll 
eToken PKI Client X86 X86 eTPKCS11.dll 
eToken PKI Client X64 X64 eTPKCS11.dll 

Primjer: 

Koristite x32 ActivClient 6.2 na x32 operativnom sustavu. Vidimo u tablici kako je potrebno upisati 

putanju do acpkcs201-ns.dll.  

Otvorite u Notepad-u dokument init.txt, na lokaciji : 

„C:\Users\Darko\AppData\Local\Temp\pkcs11\init.txt“ (umjesto user upisali smo ime korisničkog 

računa > Darko) 

Upišite lokaciju na kojoj je instaliran ActivClient (odnosno potreban dll). Odaberite „File > Save“ 

kako bi pohranili izmjene. 
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DODATNE UPUTE 

INSTALACIJA CERTIFIKATA NA RAČUNALO  

 

Prije korištenja web aplikacije JPPU korisnik mora ispuniti određene preduvjete od kojih je 

najvažniji posjedovanje korisničkog, digitalnog certifikata. Digitalni certifikat je elektronička 

isprava koja jedinstveno povezuje identitet fizičke osobe s kriptografskim ključem koji se u 

transakcijama koristi za elektroničko potpisivanje i/ili enkripciju sadržaja poruka. Putem aplikacije 

korisnici sustava se identificiraju certifikatom, no kako bi mogli odabrati odgovarajući certifikat 

potrebno je napraviti instalaciju korijenskog (Root) certifikata.  

FINA ROOT CA I SUBORDINIRANI DIGITALNI CERTIFIKAT  

Kako bi mogli vidjeti korisničke certifikate u aplikaciji JPPU preduvjet je da imate instaliran FINA 

ROOT CA i FINA SUBORDINIRANI DIGITALNI CERTIFIKAT  . Na sljedeći način možete instalirati 

certifikate: 

Fina Root CA certifikat može se preuzeti s web stranica Fine (http://www.fina.hr/finadigicert). Na 

toj stranici potrebno je pronaći link „CA certifikati“:  

 

   
 

Nakon toga pojavljuje se ekran s prikazom linkova s kojih se mogu preuzeti Fina Root CA, Fina 

RDC 2015, Fina RDC 2020 i Fina RDC-TDU 2015 certifikati (za certifikate izdane tijelima državne 

uprave) u različitim formatima:  

http://www.fina.hr/finadigicert
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Potrebno je odabrati link „Fina Root CA (samopotpisni root CA certifikat) - DER“ čime će se 

preuzeti Fina Root CA certifikat. Preuzeta datoteka ima naziv FinaRootCA.cer i najčešće će se 

nakon preuzimanja pronaći u mapi Downloads:  
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Instalacija preuzetog Fina Root CA certifikata: 

 

Kako bi se Fina Root CA certifikat certifikat instalirao u Internet Explorer dovoljan je dvostruki klik 

na datoteku FinaRootCA.cer. Nakon toga otvara se ekran gdje treba potvrditi odabir s tipkom 

„Open“:  
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Odaberite „Install Certificate…“ 
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Odaberite „Store location“ po želji. „Current User“ – samo prijavljeni korisnik može koristit 

certifikat. „Local Machine“ – svi korisnici koji se prijavljuju na računalo imat će pristup certifikatu. 

 

Ako niste sigurni što odabrati, odaberite „Current User“ i odaberite „Next“ 

 

 
 

 

 

Odaberite "Place all certificates in the following store" (odaberete Browse te folder Trusted 

Root Certification Authorities). Nakon toga kliknete "Next" te "Finish". 
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INSTALACIJA FINA ROOT CA U MOZILLA FIREFOX 

Otvorite izbornik odabirom na ikonu „  „ te odaberite „Options“ 

 

 

 

Odaberite „Privacy & Security“ 
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Unutar kartice “Privacy & Security“ odaberite „View Certificates…“ 

 

 

Odaberite „Import“ 
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Odaberite FINA RDC CA certifikat pa odaberite „Open“ 

 

 

Odaberite polja kako je označeno na slici iznad te odaberite „OK“ 

Postupak instalacije subordiniranih CA certifikata potrebno je provesti na isti način. 
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INSTALACIJA KORISNIČKIH CERTIFIKATA NA RAČUNALO  

 

Slijedite proceduru opisanu za softversku komponentu (middleware) koju koristite za čitač čip 

kartice, USB-token ili dr. Navedene su upute za Active Client softver. Ako koristite Safenet 

Authentication Client ili  eToken PKI Client, za upute o instalaciji certifikata na računalo obratite se 

poslovnoj banci koja je izdala uređaj.  

 

ACTIVE CLIENT 7 

Napomena: Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom 

slučaju obratite se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj 

te eventualno ponovo snimili certifikate. Također, ako na računalu imate instaliranu 

ActivClient verziju 6.2, istu je potrebno ukloniti s računala prije instalacije ActiveClient 

verzije 7.02 

  

Otvorite "Start-->All Programs-->ActiveIdentity-->ActivClient-->User Console-->My Certificates“ ili u 

polje za pretraživanje upišite „User Console“ 

Na jedan od certifikata (koji nije postavljen kao default-ni) kliknite desnom tipkom miša te odaberete 

„Set this as default certificate“.  

Napomena: Certifikat koji nije postavljen kao default-ni nema zelene kvačice “ “ . 

 

 

1. U Start izborniku odaberite All Programs->ActiveIdentity->ActiveClient->User Console. 

Ukoliko se zahtjeva, upišite PIN. 

2. U Active Client prozoru odaberite View->Explorer Bar->Tree View.  

 

  

 

3. Odaberite mapu My Certificates.  
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4. Na jedan od certifikata (koji nije postavljen kao default-ni )kliknete desnom tipkom miša te 

odaberete „Set this as default certificate“ 

Napomena: Certifikat koji nije postavljen kao default-ni nema zelene kvačice “ “ . 

 

 
 

Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 

preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 

certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 

 

ACTIVE CLIENT 6.2 

Napomena: Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom 

slučaju obratite se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj 

te eventualno ponovo snimili certifikate. 
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1. U Start izborniku odaberite All Programs->ActiveIdentity->ActiveClient->User Console. ili u 

polje za pretraživanje upišite „User Console“ Ako se zahtjeva, upišite PIN. 

2. U Active Client prozoru odaberite View->Explorer Bar->Tree View.  

 

 

 

3. Odaberite mapu My Certificates. Na svakom certifikatu koji glasi na ime i prezime odabrati 

desni klik miša te opciju Make Available. Ako nemate ponuđenu ovu mogućnost na 

certifikatima, pokušajte isto na folderu My Certifikates.  

Napomena: Ako korisnik nije administrator na računalu, opcija „Make available“ neće biti 

ponuđena. 

 

 

 

 

U slučaju da Make Available nije ponuđen napravite slijedeće :  

1. U prozoru Active Client odaberite „View > Toolbars > Costumize“.  

2. Na kartici Commands u polju Categories (lijeva strana) odaberite „Tools“.  

3. S desne strane, u polju Commands odaberite „Make this certificate available to Windows“ te 

držeći lijevu tipku miša odvucite navedeni gumb na alatnu traku aplikacije.  

4. Odaberite željeni certifikat i zatim „Make this certificate available to Windows“ kako bi 

omogućili upotrebu certifikata u aplikaciji JPPU.  

 

Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 

preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 
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certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 

SAFENET AUTHENTICATION CLIENT 

Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom slučaju obratite 

se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj te eventualno 

ponovo snimili certifikate. 

 

1. U Start izborniku odaberite All Programs->SafeNet-> SafeNet Authentication Client ili u polje 

za pretraživanje upišite „SafeNet“ Ako se zahtjeva, upišite PIN. 

 

 

 

2. Odaberite plus “ “ uz mapu „User certificates“ u izborniku s lijeve strane 
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3. Na jedan od certifikata pritisnite desnu kliku miša i odaberite opciju „Set as default“ 

 

 

 

 

Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 

preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 

certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 
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IDPRIME  

Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom slučaju obratite 

se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj te eventualno 

ponovo snimili certifikate. 

1. U Start izborniku odaberite All Programs-> IDPrimeClient-> IDPrimeClient ili u polje za 

pretraživanje upišite „IDPrime“ Ako se zahtjeva, upišite PIN. 

 

(Ako ne vidite certifikate u aplikaciji, odaberite gumb „Refresh readers“. Ako i dalje ne vidite 

certifikate, provjerite jeste li umetnuli certifikat u računalo, ako jeste, molimo obratite se 

pružatelju usluga digitalnih certifikata kako bi provjerili certifikate na samom uređaju.) 

 

2. Na jedan od korisničkih certifikata (onih koji sadrže vaše ime i prezime) certifikata pritisnite 

desnu kliku miša i odaberite opciju „Register Certificate“ 

 

Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 
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preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 

certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 

 

EID 

Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom slučaju obratite 

se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj te eventualno 

ponovo snimili certifikate. 

1. U Start izborniku odaberite All Programs-> AKD-> eID Middleware -> Client ili u polje za 

pretraživanje upišite „Client“ Ako se zahtjeva, upišite PIN. 

 

2. U aplikaciju se trebaju prikazati vaši osobni podaci, ako to nije slučaj, provjerite je li vam 

odabran ispravan čitač kartica u kartici “Čitač”: 
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Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 

preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 

certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 

DEVICE CLIENT 

Ako ne vidite Vaše certifikate na ovaj način, oni se ne nalaze na uređaju. U tom slučaju obratite 

se izdavatelju Vaših certifikata (FINA, poslovne banke) kao bi Vam provjerili uređaj te eventualno 

ponovo snimili certifikate. 

1. U Start izborniku odaberite All Programs-> Asseco -> DeviceClient -> ASEBAPKIDeviceClient 

ili u polje za pretraživanje upišite „DeviceClient“ Ako se zahtjeva, upišite PIN. 

 

2. Odaberite ikonu „ID Prime MD“ s lijeve strane te odaberite karticu „Certificate“ i provjerite 

nalaze li se tu Vaši certifikati: 
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Ako su vaši certifikati vidljivi u aplikaciju, a svejedno se ne možete prijaviti u aplikaciju, vrlo 

vjerojatno je problem u redoslijedu instalacija ostalih middleware programa na računalu.  

Ako koristite Device Client i ActivClient zajedno na jednom računalu, Device Client treba biti 

instaliran prije ActivClient-a. 

  

U ovom slučaju potrebno je: 

 

1. ukloniti ActivClient (Uninstall) 

2. instalirati  Device Client 

3. ponovno instalirati ActivClient. (ako Vam je potreban za druge certifikate) 

 

Ako i dalje imate problema s pristupom sustavu ePorezna pokušajte isključiti svoj Antivirus. U 

nekim situacijama upravo Antivirus blokira čitanje certifikata na računalu. U tom slučaju potrebno 

je podesiti postavke antivirusnog programa tako da ne blokira čitanje certifikata. Također, 

preporuka je da testirate u pregledniku drugačijem od onog u kojem vam ne radi očitavanje 

certifikata. Npr. ako imate problema u Internet Explorer pregledniku, pokušajte u Google Chrome 

pregledniku. 

PODEŠAVANJE MOZZILA FIREFOX ZA RAD SA SMART KARTICOM / USB KEY-EM 

Ako je Internet preglednik Mozilla FireFox instaliran nakon što je obavljena instalacija 

programskog paketa za rad sa smart karticom/USB Key-em, potrebno je obaviti dodatno 

podešavanje preglednika kako bi isti mogao komunicirati sa smart karticom/USB Key-em. Ova 

podešavanja nisu potrebna ako je na računalu Mozilla Firefox bila instalirana prilikom instalacije 

programske podrške za rad smart kartice/USB Key-a. 

Kako bi dodali modul za komunikaciju FireFox-a sa smart karticom / USB Key-em napravite 

sljedeće: 
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Otvorite izbornik odabirom na ikonu „  „ te odaberite „Options“ 

 

Odaberite „Privacy & Security“ 
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Unutar kartice “Privacy & Security“ odaberite „Security Devices“ 

 

U prozoru “Device Manager” kliknite na “Load”. Otvara se prozor za učitavanje PKCS#11 modula. 

 

U polju „Module Name“ upišite proizvoljan naziv (Npr. ActivClient).  

U polju „Module fileame“ odaberite „Browse“, zatim odaberite jedan od sljedećih .dll dokumenata 

ovisno o operativnom sustavu te verziji middleware-a, zatim odaberite gumb OK. 

 

Middleware  Operativni sustav  Gdje kopirati .dll dokumente 

ActivClient_7_02 X64 X64 C:\Program Files (x86)\ActivIdentity\ActivClient\ acpkcs211.dll 

ActivClient_7_02 X86 X86 C:\Program Files\ActivIdentity\ActivClient\ acpkcs211.dll 

ActivClient 6.2 X64 X64 C:\Program Files\ActivIdentity\ActivClient\ acpkcs211.dll 

ActivClient 6.2 X86 X64 C:\Program Files(x86)\ActivIdentity\ActivClient\ acpkcs211.dll 

ActivClient 6.2 X86 X86 C:\Program Files\ActivIdentity\ActivClient\ acpkcs211.dll 
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Athena x64 X64 C:\Windows\System32\ asepkcs.dll 

Athena x32 X32 C:\Windows\System32\ asepkcs.dll 

ADK X64 X64 C:\Program Files\AKD\eID Middleware\pkcs11\ AkdEidPkcs11.dll 

IDPrime X64 X64 C:\Program Files (x86)\IDPrimeClient\ IDPrimePKCS11.dll 

IDPrime X86 X86 C:\Windows\System32\ IDPrimePKCS11.dll 

IDGo800 X64 X64 C:\Program Files (x86)\Gemalto\IDGo 800 PKCS#11\ 

idprimepkcs11.dll 

Safenet Auth. Client 

X86  

X86 C:\Windows\SysWOW64\ eTPKCS11.dll 

Safenet Auth. Client 

X64 

X64 C:\Windows\System32\ eTPKCS11.dll 

eToken PKI Client X86 X86 C:\Windows\SysWOW64\ eTPKCS11.dll 

eToken PKI Client X64 X64 C:\Windows\System32\ eTPKCS11.dll 

 

IZMJENA PODATAKA O POREZNIM OBVEZNICIMA 

Prema informacijama u korisničkom priručniku svaki korisnik sustava može izmijeniti određene 

podatke poreznih obveznika za koje ima potrebno ovlaštenje. U slučaju da postoje automatski 

registrirane osobe ovlaštene za zastupanje poslovnog subjekta, tada navedene osobe mogu 

mijenjati podatke o poreznim obveznicima, dok ostalim ovlaštenim osobama nije moguće 

izmijeniti podatke. 

E-mail, telefon i fax koji se mogu unijeti/izmijeniti navedeni su u modulu „Profil“ unutar kojeg se 

nalazi modul „Informacije o poreznom obvezniku“. 

Korisnik s razlogom upisa 15 (inozemni dohodak) ima dodatno polje „Dostava akata elektroničkim 

putem“ te mogućnost promjene istoga koje služi za davanje pristanka o elektroničkoj dostavi 

akata putem korisničkog pretinca. Ovim podatkom korisnik odlučuje hoće li na zadanu e-mail 

adresu poreznog obveznika dolaziti obavijesti o pristiglim informativnim porukama (kategorije 

„Opće obavijesti“) u korisničkom pretincu. 

Unutar kartice „Osnovni podaci“ nalaze se osnovni podaci o poreznom obvezniku iz RPO-a 

(Registar poreznih obveznika). Koji će se podaci prikazivati ovisi o tipu poreznog obveznika. 

Upisani podaci će se koristiti za automatsku ispunu zaglavlja elektroničkih obrazaca kako bi se 

olakšao postupak popunjavanja istih. 

Informacijama o poreznom obvezniku moguće je pristupiti i odabirom na poveznicu naziva 

poreznog obveznika, te nakon toga u padajućem izborniku odabrati poveznicu „INFORMACIJE O 

POREZNOM OBVEZNIKU“. 

KAKO ISPRAVITI VEĆ POSLANI OBRAZAC?  

Kako bi ispravili obrazac koji ste prethodno poslali u sustav JPPU dovoljno je poslati novi obrazac 

koji želite ispraviti za isto razdoblje. Svaki sljedeći poslani obrazac za isto razdoblje smatra se 

ispravkom prethodno poslanog obrasca. 

KAKO ISPRAVITI VEĆ POSLANI JOPPD OBRAZAC? 
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Kako bi ispravili JOPPD obrazac koji ste prethodno potpisali i poslali u sustav JPPU, a isti je 

uspješno obrađen potrebno je poslati novi Obrazac JOPPD koji mora sadržavati slijedeće podatke: 

1. na stranici A: 

1.1. pod I. upisuje se istovjetna oznaka izvješća Obrasca JOPPD kao i u izvornom Obrascu 

JOPPD,  

1.2. pod II. upisuje se oznaka 2, 

1.3. pod III. upisuju se podaci koji su istovjetni podacima upisanim na izvornom Obrascu 

JOPPD,  

1.4. pod IV.1. upisuje se broj osoba za koje se mijenjaju podaci (broj pojedinačnih OIB-a na 

stranici B Obrasca JOPPD kojim se radi ispravak), 

1.5. pod IV.2. upisuje se zadnji broj retka na popisu pojedinačnih obračuna sa stranice B 

Obrasca JOPPD kojim se obavlja ispravak,  

1.6. pod V., VI. i VII. upisuje se zbroj stupaca sa stranice B obrasca kojim se obavlja ispravak, 

prema pravilima koji vrijede kao i kod formiranja izvornog obrasca,  

 

2. na stranici B: 

2.1. pod I., II. i 1. obvezno se upisuju podaci koji su istovjetni podacima upisanim na 

izvornom Obrascu JOPPD,  

2.2. pod III. unosi se oznaka 2,  

2.3. pod IV. obvezno se upisuje redni broj stranice (npr. ukoliko je samo jedna stranica B 

upisuje se 1/1), 

2.4. pod 4. i 5. obvezno se upisuju podaci koji su istovjetni podacima upisanim na izvornom 

Obrascu JOPPD,  

2.5. Pod ostalim podacima popunjavaju se svi ostali stupci odgovarajućeg retka koji se 

mijenja prema pravilima koji vrijede kao i kod formiranja izvornog obrasca, ovisno o vrsti 

obračuna i to sa svim podacima koji su trebali biti upisani na izvornom izvješću da nisu 

nastupile okolnosti zbog kojih se ispravak obavlja. 

 

Ako je JOPPD obrazac koji ste prethodno potpisali i poslali pogrešan (nije obrađen), potrebno je 

u roku 24 h od trenutka kada je obveznik putem sustava JPPU kao i putem elektroničke pošte koju 

je naveo na A strani Obrasca JOPPD obaviješten da je podnijeti obrazac pogrešan, dostaviti 

ponovno izvorno izvješće (vrsta izvješća 1) s obzirom na to da se odbijanje zaprimanja izvornog 

JOPPD obrasca uslijed logičkih, matematičkih i formalnih nedostataka ne smatra razlogom 

podnošenja ispravaka izvornog JOPPD-a. Dodatne informacije o JOPPD obrascu možete pronaći 

u dokumentu „Kratke upute za Građane – Obrazac JOPPD“ 

https://e-porezna.porezna-uprava.hr/Upute/G2B/ePorezna%20G2B-%20Kratke%20upute%20za%20gra%C4%91ane-%20Obrazac%20JOPPD.pdf

